Installation Guide

SAP NetWeaver Composition Environment 7.1 SR5 on Windows: IBM DB2 for i5/OS

Production Edition

Target Audience

- System Administrators
- Technical Consultants

Document version: 1.1 - 05/16/2008
Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at http://www.sdn.sap.com/irj/sdn/nw-ce.

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>5/16/2008</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>


Table of Contents

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Introduction</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>How to Use This Guide</td>
<td>5</td>
</tr>
<tr>
<td>1.2</td>
<td>New Features</td>
<td>5</td>
</tr>
<tr>
<td>1.3</td>
<td>SAP Notes for the Installation</td>
<td>6</td>
</tr>
<tr>
<td>1.4</td>
<td>Online Information from SAP</td>
<td>8</td>
</tr>
<tr>
<td>1.5</td>
<td>Accessing the SAP Library</td>
<td>9</td>
</tr>
<tr>
<td>1.6</td>
<td>Naming Conventions</td>
<td>10</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2</th>
<th>Planning</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1</td>
<td>Installation Options Covered by this Guide</td>
<td>13</td>
</tr>
<tr>
<td>2.1.1</td>
<td>Standard System</td>
<td>13</td>
</tr>
<tr>
<td>2.1.2</td>
<td>Distributed System</td>
<td>14</td>
</tr>
<tr>
<td>2.1.3</td>
<td>Additional Application Server Instance</td>
<td>15</td>
</tr>
<tr>
<td>2.1.4</td>
<td>Standalone Host Agent</td>
<td>17</td>
</tr>
<tr>
<td>2.2</td>
<td>Domain or Local Installation</td>
<td>18</td>
</tr>
<tr>
<td>2.3</td>
<td>SAP System Transport Host</td>
<td>19</td>
</tr>
<tr>
<td>2.4</td>
<td>Running Adobe Document Services on Non-supported Platforms</td>
<td>20</td>
</tr>
<tr>
<td>2.5</td>
<td>Integration of LDAP Directory Services</td>
<td>20</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 3</th>
<th>Preparation</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Basic SAP System Parameters</td>
<td>25</td>
</tr>
<tr>
<td>3.2</td>
<td>Hardware and Software Requirements</td>
<td>26</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Running the Prerequisite Checker in Standalone Mode (Optional)</td>
<td>31</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Requirements for the Additional Application Server Instance</td>
<td>32</td>
</tr>
<tr>
<td>3.2.3</td>
<td>Requirements for the Host Agent as a Separate Installation</td>
<td>33</td>
</tr>
<tr>
<td>3.3</td>
<td>Checking the Windows File System</td>
<td>34</td>
</tr>
<tr>
<td>3.4</td>
<td>Checking the Windows Domain Structure</td>
<td>35</td>
</tr>
<tr>
<td>3.5</td>
<td>Reducing the Size of the File Cache</td>
<td>36</td>
</tr>
<tr>
<td>3.6</td>
<td>Required User Authorization for the Installation</td>
<td>37</td>
</tr>
<tr>
<td>3.7</td>
<td>Performing a Domain Installation Without Being a Domain Administrator</td>
<td>38</td>
</tr>
<tr>
<td>3.8</td>
<td>Preparing System for Windows File System Access</td>
<td>39</td>
</tr>
<tr>
<td>3.9</td>
<td>Installing the JDBC Driver</td>
<td>40</td>
</tr>
<tr>
<td>3.10</td>
<td>Configuring Windows Transport Systems</td>
<td>41</td>
</tr>
<tr>
<td>3.11</td>
<td>Preparing the SAP System Transport Host</td>
<td>42</td>
</tr>
<tr>
<td>3.12</td>
<td>Preparing the Installation DVDs</td>
<td>43</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Installation</td>
<td>49</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------</td>
<td>----</td>
</tr>
<tr>
<td></td>
<td>Running SAPinst</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>SAPinst Installation Options</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Installing Additional Components (Optional)</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>Installing SAP Memory Analyzer (Optional)</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td></td>
<td>56</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>Post-Installation</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>Configuring the Windows Server 2008 Firewall</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>Logging On to the Application Server</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>Ensuring User Security</td>
<td>61</td>
</tr>
<tr>
<td></td>
<td>Creating Symbolic Links on Windows Server 2008 for Application Servers</td>
<td>64</td>
</tr>
<tr>
<td></td>
<td>Configuring the Transport Management System</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Configuring the Remote Connection to SAP Support</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Applying the Latest Kernel and Support Packages</td>
<td>65</td>
</tr>
<tr>
<td></td>
<td>Post-Installation Steps for the Host Agent</td>
<td>66</td>
</tr>
<tr>
<td></td>
<td>Checking the SAP Java Documentation</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>CE-Specific Post-Installation Activities</td>
<td>68</td>
</tr>
<tr>
<td></td>
<td>Performing a Full System Backup</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>Post-Installation Steps for the Diagnostics Agent</td>
<td>72</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>Additional Information</th>
<th>73</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Transporting Self-Developed Software Component Archives (SCA) into the System</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Configuration Templates</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Uninstalling SAP NetWeaver Composition Environment</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>SAP Directories</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Starting and Stopping the SAP System</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>SAP System Security on Windows</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>Automatic Creation of Accounts and Groups</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Deleting an SAP System</td>
<td>82</td>
</tr>
</tbody>
</table>
1 Introduction

Note
This document only applies if you are installing on a Windows operating system against IBM DB2 for i5/OS.

This document explains how to install an SAP NetWeaver Composition Environment system as productive edition.
For more information about SAP NetWeaver Composition Environment, see http://sdn.sap.com/irj/sdn/nw-ce.

Constraints
You need to consider the following constraints before you start your installation:

- You must only use the SAP installation tools according to the instructions and for the purposes described in the SAP installation document. Improper use of the SAP installation tools can damage files and systems already installed.
- SAP system installations should only be performed by SAP Technical Consultants certified for your operating system, your database, and the SAP system that you are installing.
- For downward-compatible releases of DB/OS platforms for SAP products, SAP plans to regularly release the newest database (DB) and operating-system (OS) versions of SAP products. These releases are downward-compatible with earlier SAP system releases.

Note that for already shipped SAP components, we only support the installation for database versions proposed by the installation tool. Therefore, you must install an SAP component or perform a system copy using a downward-compatible database as follows:

- Install the component with the old proposed database version.
- Upgrade the old database version to the downward-compatible new version.

1.1 How to Use This Guide

At the beginning of each installation phase – planning, preparation, installation, and post-installation – you find a list of the steps that you have to perform in that phase, as well as additional information. Detailed information about the steps for each phase is available in the relevant chapter.

When you plan the installation, you have to decide what exactly you want to install, because the steps within each phase vary according to the installation option you choose.

The following installation options are described in this document:
1.2 New Features

Here you can find the new features in this release.

Note

Many installation concepts have changed, so make sure that you read the installation guide carefully.

Caution

Make sure that you read the release notes for your SAP system. You can find these at http://service.sap.com/releasenotes.

SAP System Installation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APins</td>
<td>SAPinst has the following new features:</td>
</tr>
<tr>
<td></td>
<td>■ The technical terms used for the instances of an SAP system have changed as follows:</td>
</tr>
<tr>
<td></td>
<td>■ “Central instance” (CI) is now called “primary application server instance”.</td>
</tr>
<tr>
<td></td>
<td>■ “Dialog instance” (DI) is now called “additional application server instance”.</td>
</tr>
<tr>
<td></td>
<td>■ “Central system” — meaning an SAP system running on one single host — is now called “standard system”.</td>
</tr>
<tr>
<td></td>
<td>■ Host agent</td>
</tr>
<tr>
<td></td>
<td>The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components, except TREX.</td>
</tr>
<tr>
<td></td>
<td>The host agent is automatically installed with your SAP system.</td>
</tr>
<tr>
<td></td>
<td>You can also install a standalone host agent with SAPinst. There is a new installation option Host Agent available under Software Life-Cycle Options.</td>
</tr>
<tr>
<td></td>
<td>You only need to install a standalone host agent in the following cases:</td>
</tr>
<tr>
<td></td>
<td>■ You want to centrally monitor a host that does not have an SAP component.</td>
</tr>
<tr>
<td></td>
<td>■ You want to perform an upgrade to SAP NetWeaver.</td>
</tr>
<tr>
<td></td>
<td>■ The locations of all installation DVDs can be entered on one screen.</td>
</tr>
<tr>
<td>Area</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Software Deployment Manager (SDM)</td>
<td>The Software Deployment Manager (SDM) is no longer part of the primary application server instance of a Java-only system. Therefore, there is no longer any technical difference between the primary application server instance and the additional application server instance of a Java-only system. The SAP system directory of both instances is now called J&lt;instance_number&gt;. J&lt;instance_number&gt; no longer exists.</td>
</tr>
<tr>
<td>Installation DVDs</td>
<td>You start the installation from the Installation Master DVD for your database.</td>
</tr>
<tr>
<td>Java Library</td>
<td>There is no longer a Java library for Java systems. Everything is now in the kernel. You no longer need APYJ2EELIB and RXYJ2EELIB.</td>
</tr>
<tr>
<td>SAP Java Virtual Machine (SAP JVM)</td>
<td>You no longer have to download and install a Java Development Kit (JDK) from another software vendor as a prerequisite for the installation with SAPInst. The SAP JVM is a Java Development Kit (JDK) provided and supported by SAP. The SAP JVM is fully compliant to the Java Standard Edition 5. It is available on the Installation Master DVD and is installed automatically by SAPInst when you start the installation.</td>
</tr>
<tr>
<td>Visual Administrator tool integrated in SAP NetWeaver Administrator</td>
<td>SAP NetWeaver Administrator is a brand new solution for monitoring and administering Java systems and their applications. It is a web-based tool for administration, configuration, and monitoring. The Visual Administrator tool is no longer available as a separate tool. It has been integrated in the SAP NetWeaver Administrator. SAP NetWeaver Administrator offers you most of the functions previously available in Visual Administrator, but redesigned for the task-oriented approach of SAP NetWeaver Administrator. For more information about SAP NetWeaver Administrator, see the SAP NetWeaver Master Guide and the following: <a href="http://www.sdn.sap.com/irj/sdn/netweaver">http://www.sdn.sap.com/irj/sdn/netweaver</a> » Lifecycle Management » Operations » Knowledge Center » Administration »</td>
</tr>
</tbody>
</table>
| SAP Solution Manager Diagnostics Agent     | A SAP Solution Manager Diagnostics Agent (Diagnostics Agent) is a standalone Java program that runs on each of the systems managed by SAP Solution Manager Diagnostics. It gathers information and reports to the SAP Solution Manager system. For more information about the Diagnostics Agent, see [http://service.sap.com/diagnostics](http://service.sap.com/diagnostics). The installation of the Diagnostics Agent is now part of the Installation Master DVD. That is, you can choose between the following options:  
  - If there is no Diagnostics Agent already installed on this physical or virtual host, it is installed automatically with an AS Java primary application server instance and additional application server instance.  
  - You can also install it as a standalone engine, for example if you want a non-SAP system to be managed by SAP Solution Manager Diagnostics. The installation of the Diagnostics Agent as a standalone engine is not described in this installation guide, but in the Diagnostics Agent Setup Guide, which is available at [http://service.sap.com/diagnostics](http://service.sap.com/diagnostics). |
### 1.3 SAP Notes for the Installation

You **must** read the following SAP Notes **before** you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note, which you can find at [http://service.sap.com/notes](http://service.sap.com/notes).

#### SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>966719</td>
<td>SAP NetWeaver Inst. Based on Kernel 7.10: IBM DB2 for i5/OS</td>
<td>Platform-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>965569</td>
<td>SAP NetWeaver Installation Based On Kernel 7.10: Windows</td>
<td>Windows-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems</td>
</tr>
</tbody>
</table>
### 1.4 Online Information from SAP

More information is available online as follows.

#### Documentation

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
</table>

#### General Quick Links

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td><a href="http://service.sap.com/notes">http://service.sap.com/notes</a></td>
</tr>
<tr>
<td>Product Availability Matrix (PAM)</td>
<td><a href="http://service.sap.com/pam">http://service.sap.com/pam</a></td>
</tr>
</tbody>
</table>
### 1.5 Accessing the SAP Library

For more information about SAP NetWeaver, access the SAP Library from the SAP Help Portal at [http://help.sap.com](http://help.sap.com).

The references to SAP NetWeaver Library documentation in this documentation always refer to the following entry point on the SAP Help Portal:

#### 1.6 Naming Conventions

In this documentation, the following naming conventions apply:

**Terminology**
- **SAP system** refers to SAP NetWeaver CE 7.1.
Diagnostics Agent refers to SAP Solution Manager Diagnostics Agent.

SAP System ID
The SAP system ID is abbreviated to SID and SAPSID or sid and sapsid. For <sid> / <sapsid>, substitute your SAP system ID in lower case characters, for example, pd. For <SID> / <SAPSID>, substitute your SAP system ID in upper case characters, for example, PRD.

IBM System i and Short Forms
In this document, the short form “System i” is used for “IBM System i”. In previous versions of this document, “IBM System i” was referred to as “IBM eServer iSeries” or “IBM AS/400”.

IBM DB2 for i5/OS and Short Forms
In this document, the short form “DB2 for i5/OS” is used for the database “IBM DB2 for i5/OS”, and in certain cases, the SAP ID “DB4” is used as well. In previous versions of this document, “IBM DB2 for i5/OS” was referred to as “IBM DB2 Universal Database for iSeries” or “IBM DB2 Universal Database for AS/400” or “DB2/400”.

IBM i5/OS and Short Forms
In this document, the short form “i5/OS” is used for the operating system “IBM i5/OS”. In previous versions of this document, “IBM i5/OS” was referred to as “IBM OS/400”.

Variables

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;sid&gt; and &lt;sapsid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;host_name&gt;</td>
<td>Name of the corresponding host</td>
</tr>
<tr>
<td>&lt;INSTDIR&gt;</td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td>&lt;DVD_DIR&gt;</td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td>&lt;OS&gt;</td>
<td>Operating system name within a path</td>
</tr>
</tbody>
</table>

The following example shows how the variables are used:

Example
Log on as user <sapsid>adm and change to the directory \usr\sap\<SAPSID>. If your SAP system ID is C11, log on as user c11adm and change to the directory: \usr\sap\C11.
This page is intentionally left blank.
2 Planning

This section provides general planning information.

You must first:

1. Plan your SAP system landscape according to the Master Guide and the Technical Infrastructure Guide available for your product.
2. Decide on your installation option [page 13].

Now continue with the section for your chosen installation option below.

Additional Application Server Instance
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 25].

Host Agent as a Standalone Installation
You do not have to perform any planning steps.
You can immediately continue with Preparation [page 25].

2.1 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide.

- You can install one or more additional application server instance(s) [page 15] to an existing standard, distributed or high-availability system.
- You can install a standalone host agent [page 17].

2.1.1 Standard System

Note
A standard system for IBM DB2 for i5/OS is only installed on System i.

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance
Optionally you can install one or more additional application server instances. For more information, see *Additional Application Server Instance* [page 15].

### 2.1.2 Distributed System

**Note**

A distributed system for IBM DB2 for i5/OS is only installed on System i.

In a distributed system, every instance can run on a separate host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

Optionally you can install one or more additional application server instances. For more information, see *Installation of an Additional Application Server Instance* [page 15].
2.1.3 Additional Application Server Instance

You can install one or more additional application server instance(s) for an existing SAP system. An additional application server instance can run on:

- The host of any instance of the existing SAP system
- On a dedicated host

⚠️ **Note**

It is not recommended to install additional application server instance(s) on the SAP global host.

**Additional Application Server Instance for a Standard System**

The following figure shows additional application server instances that are running on dedicated hosts.
Figure 3: Additional Application Server Instance for a Standard System

For additional information, see the section Standard System in the System i installation guide.

Additional Application Server Instance for a Distributed System
The following figure shows additional application server instances that are running on dedicated hosts.
2.1.4 Standalone Host Agent

Using the host agent you can centrally monitor any host with the Alert Monitor or the SAP NetWeaver Administrator or the Adaptive Computing Controller (ACC). In addition, the host agent is used by the ACC for starting, stopping, and relocating SAP instances and databases. For more information on the ACC see http://sdn.sap.com/irj/sdn/adaptive.

The host agent is automatically installed during the installation of all SAP NetWeaver instances and components.

You only need to install a standalone host agent in the following cases:

- You want to manage a host that does not have an SAP instance or component.
- You have upgraded your SAP system to SAP NetWeaver 7.1 or higher and want to the instances of the upgraded system to be managed by the ACC.
The host agents contain the following elements:

- The control program `saphostexec`
- The SAP NetWeaver Management agent `SAPHostControl (sapstartsrv in host mode)`
- The `sapacosprep` executable of the Adaptive Computing Infrastructure
- The operating system collector `saposcol`

More Information
For more information about the host agent, see the SAP Library [page 10]:

- Function-Oriented View
- Application Server ABAP
- Administration Tools for AS ABAP
- Monitoring in the CCMS
- Infrastructure of the NetWeaver Management Agents

### 2.2 Domain or Local Installation

Before you install the SAP system, you have to decide whether you want to perform a **domain** or **local** installation, since this affects how the user account information is stored and accessed. For more information about the differences between a local and domain installation, see the Microsoft article *Deciding Between Workgroups and Domains* at:


**Note**
For System i you typically use the local installation.
Domain Installation

In a domain installation, the user account information is stored centrally in one database on the domain controller and is accessible to all hosts in the system.

You have to perform a domain installation if one of the following applies:

- You install a distributed system (strongly recommended to avoid authorization problems).
- You use a common transport host for several SAP systems running on different computers.

Local Installation

In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine (standard system), you can perform a local installation.

Note

If your SAP system was installed as a local installation and you want to later change to a domain installation, you must perform a homogeneous system copy. For more information, see the documentation Homogeneous and Heterogeneous System Copy for SAP Systems based on SAP NetWeaver at:

http://service.sap.com/instguides <your product> 4

More Information

Required User Authorization for the Installation [page 37]

2.3 SAP System Transport Host

The transport host contains the transport directory that is used by the SAP transport system to store transport data and change information of SAP systems, such as software programs, data dictionary data, or customization data. If you have several SAP systems they are usually organized in transport domains. In most cases, all SAP systems in a transport domain have a common transport directory.

For more information, see the SAP Library [page 10]:


When you install an SAP system, SAPInst by default creates the transport directory on the primary application server instance host in /usr/sap/trans.

You have to prepare this host for use by the new SAP system if one of the following applies to you:

- You want to locate the transport directory on another host.
- You want to use an existing transport host and directory in your SAP system landscape.

For more information, see Preparing the SAP System Transport Host [page 44].
More Information
SAP Directories [page 75]

2.4 Running Adobe Document Services on Nonsupported Platforms

Adobe document services (ADS) are currently not supported to run natively on all platforms supported by SAP systems based on SAP NetWeaver, in particular on 64-bit platforms.

Procedure
To use ADS in SAP landscapes on nonsupported platforms, install an additional standalone AS Java on a platform supported by ADS.
For more information, see SAP Note 925741.

Note
Currently, System i supports ADS only on double-stack systems. For Java systems such as CE, you must install an additional AS Java on a platform supported by ADS.

More Information
For more information about running ADS on SAP systems based on SAP NetWeaver, see http://sdn.sap.com/irj/sdn/adobe.

2.5 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol (LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the directory.
LDAP defines a standard protocol for accessing directory services, which is supported by various directory products such as Microsoft Active Directory, and OpenLDAP s1apd. Using directory services enables important information in a corporate network to be stored centrally on a server. The advantage of storing information centrally for the entire network is that you only have to maintain data once, which avoids redundancy and inconsistency.
If an LDAP directory is available in your corporate network, you can configure the SAP system to use this feature. For example, a correctly configured SAP system can read information from the directory and also store information there.
Note
The SAP system can interact with the Active Directory using the LDAP protocol, which defines:
- The communication protocol between the SAP system and the directory
- How data in the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows server, you can configure the SAP system to use the information available there. In the following text, directories other than the Active Directory that implement the LDAP protocol are called *generic LDAP directories.*

Caution
This section does **not** provide information about the use of LDAP directories with the LDAP Connector. For more information about using and configuring the LDAP Connector for an ABAP system, see the *SAP Library* [page 10]:
- Function-Oriented View
- Security
- Identity Management
- Identity Management of the Application Server ABAP
- Configuration of Identity Management
- Directory Services
- LDAP Connector

Prerequisites
You can only configure the SAP system for Active Directory services or other LDAP directories if these are **already available** on the network. As of Windows 2000 or higher, the Active Directory is automatically available on all domain controllers. A generic LDAP directory is an additional component that you must install separately on a UNIX or Windows server.

Features
In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory by using:
- SAP Logon
- The SAP Microsoft Management Console (SAP MMC)

For more information about the automatic registration of SAP components in LDAP directories and the benefits of using it in SAP Logon and SAP MMC, see the documentation *SAP System Information in Directory Services* on SAP Service Marketplace at:

SAP Logon
Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the *sapmsg.ini* configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon to use the LDAP directory, it queries the directory each time *Server* or *Group* selection is chosen to fetch up-to-date information on available SAP systems.

To use LDAP operation mode, make sure that the *sapmsg.ini* file contains the following:
If you use an Active Directory, you must set `LDAPoptions="DirType=NT5ADS"`. For more information, see the SAP system profile parameter `ldap/options`.

- You must specify the directory servers (for example, `LDAPserver=pcintel6 p24709`) if either of the following is true:
  - The client is not located in the same domain forest as the Active Directory
  - The operating system does not have a directory service client (Windows NT and Windows 9X without installed `dsclient`).

  For more information, see the SAP system profile parameter `ldap/servers`.

- For other directory services, you can use `LDAPnode` to specify the distinguished name of the SAP root node. For more information, see the SAP system profile parameter `ldap/saproot`.

**SAP MMC**

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. It is automatically set up when you install an SAP system on Windows. If the SAP system has been prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various sources, including the Active Directory.

Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together with Active Directory services. You can keep track of significant events in all of the systems from a single SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such changes are automatically updated in the directory and subsequently reflected in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the instances running on Unix.
You can also use the SAP Management Console (SAP MC) for administering and monitoring SAP systems from a central location. For more information about the SAP MC and about how to configure it to access LDAP directories, see the SAP Library [page 10]:
- Administrator’s Guide
- Technical Operations for SAP NetWeaver
- Administration of SAP NetWeaver Systems
- AS Java (Application Server Java)
- Administration Tools
- SAP Management Console

Configuration Tasks for LDAP Directories
This section describes the configuration tasks you have to perform for the Active Directory or other (generic) LDAP directories.

Configuration Tasks for Active Directory
To enable an SAP system to use the features offered by the Active Directory, you must configure the Active Directory so that it can store SAP system data.
To prepare the directory, you use SAPInst to automatically:

- Extend the Active Directory schema to include the SAP-specific data types
- Create the domain accounts required to enable the SAP system to access and modify the Active Directory. These are the group SAP_LDAP and the user sap1dap.
- Create the root container where information related to SAP is stored
- Control access to the container for SAP data by giving members of the SAP_LDAP group permission to read and write to the directory

You do this by running SAPInst [page 49] and choosing:
- <SAP System> » Software Life-Cycle Options » LDAP Registration » Active Directory Configuration

Note
You have to perform the directory server configuration only once. Then all SAP systems that need to register in this directory server can use this setup.

Configuration Tasks for Generic LDAP Directories
To configure other LDAP directories, refer to the documentation of your directory vendor. The SAPinst Installation Master DVD contains schema extensions for directory servers Netscape/iPlanet (ldregns4.txt) and OpenLDAP slapd (ldregslapd.schema). Both files are located in the directory \DATA_UNITS\IM_<platform>\COMMON\ADS. After you have applied the schema extension, you need to create a root container to store the SAP-related information and create a directory user that the SAP application server can use to write information to the directory.
For more information about how to set up a Netscape/iPlanet directory server, see the documentation SAP System Information in Directory Services on SAP Service Marketplace at:
- http://service.sap.com/msplatforms
- Microsoft
- Windows Server

05/16/2008
05/16/2008
Enabling the SAP System LDAP Registration

Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP system by setting some profile parameters in the default profile.

To do this, run SAPinst [page 49] once for your system and choose:

- <SAP System> > Software Life-Cycle Options > LDAP Registration > LDAP Support

If you use a directory server other than Microsoft Active Directory and/or non-Windows application servers, you have to store the directory user and password information by using ldappasswd pf=<any_instance_profile>. The information is encrypted for storage in DIR_GLOBAL and is therefore valid for all application servers. After restarting all application servers and start services, the system is registered in your directory server. The registration protocols of the components are dev_ldap*. The registration is updated every time a component starts.
3 Preparation

This section includes the preparation steps that you have to perform for the:

- Additional application server instance
- Standalone host agent

**Additional Application Server Instance**

You have to perform the following preparations on the host where you install the additional application server instance(s):

1. You check the hardware and software requirements [page 31].
2. You check the Windows file system [page 35].
3. You check that your host belongs do the correct Windows domain [page 36].
4. You reduce the size of the file cache [page 37].

**Note**

This step is not required if you use Windows Server 2008.

5. You check that you have the required user authorization for the installation [page 37].
6. If required, you perform a domain installation without being a domain administrator [page 39].
8. You install the JDBC Driver [page 42].
10. You make sure that the required installation media [page 45] are available.
11. You can now continue with Installation [page 49].

**Standalone Host Agent**

You have to perform the following preparations on the host where you install the host agent separately:

1. You identify basic SAP system parameters [page 26].
2. You check the hardware and software requirements [page 31].
3. You check the Windows file system [page 35].
4. You reduce the size of the file cache [page 37].

**Note**

This step is not required if you use Windows Server 2008.
5. You check that you have the required user authorization for the installation [page 37].
6. If required, you perform a domain installation without being a domain administrator [page 39].
9. You make sure that the required installation media [page 45] are available.
10. You can now continue with Installation [page 49].

3.1 Basic SAP System Parameters

SAPinst asks whether you want to run the installation in Typical or Custom mode.
If you choose Typical, SAPinst provides automatic default settings and you only have to respond to a minimum number of prompts. However, you can still change any of the default settings on the parameter summary screen.
The tables below list the basic system parameters that you always need to specify before installing your SAP system, both in typical and in custom mode.
For all other SAP system parameters, use the [F1] help in the SAPinst dialogs.

SAP System ID and Database ID

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP system ID &lt;SAPSID&gt; identifies the entire SAP system. SAPinst prompts you for the &lt;SAPSID&gt; when you execute the first installation option to install a new SAP system. If there are further installation options to be executed, SAPinst prompts you for the profile directory. For more information, see the description of the parameter SAP System Profile Directory.</td>
</tr>
</tbody>
</table>

Example
This prompt appears when you install the central services instance, which is the first instance to be installed in a distributed system.

Caution
Choose your SAP system ID carefully. Renaming is difficult and requires you to reinstall the SAP system.

Make sure that your SAP system ID:
- Is unique throughout your organization
- Consists of exactly three alphanumeric characters
- Contains only uppercase letters
- Has a letter for the first character
- Does not include any of the following, which are reserved IDs:
### 3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID <code>&lt;SMDSID&gt;</code> of SAP Solution Manager Diagnostics Agent</td>
<td>SAPInst sets <code>&lt;SMDSID&gt;</code> to DAA by default. If DAA is already used by another SAP system that is not a Diagnostics Agent instance, <code>&lt;SMDSID&gt;</code> is set to DA&lt;x&gt;, where &lt;x&gt; can be any letter from A to Z, and DA stands for “DiagnosticsAgent”). If required, you can change <code>&lt;SMDSID&gt;</code> to a value of your choice on the Parameter Summary screen. If you do so, the same naming conventions as for <code>&lt;SAPSID&gt;</code> apply. For more information, see entry “SAP System ID <code>&lt;SAPSID&gt;</code>” in this table above.</td>
</tr>
</tbody>
</table>

### SAP System Profile Directory

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\\&lt;SAPGLOBALHOST&gt;\sapmnt\&lt;SAPSID&gt;\SYS\profile</code></td>
<td>The installation retrieves the parameters entered earlier from the SAP system profile directory. SAPInst prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation. See also the description of the parameters SAP System ID and Database ID.</td>
</tr>
</tbody>
</table>

**Note**

If you install an additional application server instance in an existing SAP system, SAPInst also prompts you for the profile directory of the existing SAP system.

### SAP System Instances, Hosts, and Ports

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Instance Number of the SAP system               | **Instance Number:** Technical identifier that is required for every instance of an SAP system, consisting of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. The instance number is used to specify the names of the SAP system instance directories which are created automatically by SAPInst during the installation:  
  - The directory both of the primary application server instance and of an additional application server instance is called J<Instance_Number>.  
  - The directory of the central services instance is called SCS<Instance_Number>. For more information, see *SAP Directories* [page 75]. |

**Caution**

Do **not** use 89 for the instance number because it is used by Windows Terminal...
### Parameters

<table>
<thead>
<tr>
<th><strong>Parameters</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
</table>
| Instance Number for the Diagnostics Agent          | Technical identifier for internal processes for the Diagnostics Agent, consisting of a two-digit number from 00 to 98. The instance number is set automatically to the next free and valid instance number that has not yet been assigned to the SAP system. The instance number is used to specify the name of the Diagnostics Agent instance directory which are created automatically by SAPInst during the installation: The directory of the Diagnostics Agent instance is called \`<Instance_Number>`.
For more information, see *SAP Directories* [page 75].
The same restrictions apply as in “Instance Number of the SAP system” (see above). |
| Virtual Host Name                                   | You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to order to conceal their physical network identities from each other. This may be useful when moving SAP servers or complete server landscapes to other new hardware within a short time frame without having to carry out a reinstalltion or complicated reconfiguration.
If you want to use virtual host names for the installation, you have to specify the virtual host name before you *start SAPInst* [page 49].
Virtual host names are also required for a high-availability (HA) system. You need to specify the virtual host name, which is used by the (A)SCS instance.
  * For more information about the use of virtual TCP/IP host names, see *SAP Note 962955*.
  * The host name must not exceed 12 characters. For more information about the allowed host name length and characters, see *SAP Note 611361*. |
| Message Server Port                                | **Caution**
The message server port number must be unique for the SAP system on all hosts. If there are several message port numbers on one host, all must be unique.                                                                 |

**Port Number of the SAP Message Server:**
If you do not specify a value, the default port number is used.
The SCS instance profile contains the configuration for the Java message server. The Java message server port uses the parameter `rtsp/mssrv_internal` with default value `39<nn>`, where `<nn>` is the instance number of the SCS message server instance.
For more information about the parameters used for message server ports, see *SAP Note 821875*. |
### Master Password

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Password</td>
<td>This password is used for all new user accounts SAPinst creates and for the secure store key phrase. The length has to be 8 to 14 characters. Depending on your installation scenario there might be more restrictions.</td>
</tr>
</tbody>
</table>

**Caution**

If you do not create the operating system users manually, SAPinst creates them with the common master password. For more information, see the description of the parameter Operating System Users. In this case, make sure that the master password meets the requirements of your operating system and of your database.

### Operating System Users of the SAP System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Password of Operating System Users | SAPinst processes the passwords of operating system users as follows:  
- If the operating system users do **not** exist, SAP creates the following users:  
  - `<sapid>adm`  
    This user is the SAP system administrator user and is a member of the local Administrators group.  
  - `SAPService<SAPSID>`  
    This user is the Windows account to run the SAP system. It is not a member of the local Administrators group.  
  - `sapadm`  
    The host agent user `sapadm` is used for central monitoring services and is a member of the local Administrators group.  
  
SAPinst sets the master password for these users by default. You can overwrite and change the passwords either by using the parameter mode Custom or by changing them on the parameter summary screen.  

- If the operating system users already exist, SAPinst prompts you for the existing password, except the password of these users is the same as the master password.  

**Caution**

Make sure that you have the required user authorization [page 37] for these accounts before you start the installation.

| Operating System Users | SAPinst creates the `<sapid>adm` and `SAPService<SAPSID>` user in the domain specified. Make sure that you have domain administrator rights before you start the installation. If not, you have to create these users manually before starting the installation. For more information, see Required User Authorization for the Installation [page 37]. |
User Management Engine (UME)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Using the Java Database:</strong></td>
<td></td>
</tr>
<tr>
<td>Java Administrator User</td>
<td>SAPInst sets the user name <strong>Administrator</strong> and the master password by default. If required, you can choose another user name and password according to your requirements.</td>
</tr>
<tr>
<td>Java Guest User</td>
<td>SAPInst sets the user name <strong>Guest</strong> and the master password by default. The <strong>Guest</strong> user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <strong>Authenticated Users</strong> and have read access only.</td>
</tr>
<tr>
<td><strong>Using an External ABAP System – Parameters for the ABAP Connection:</strong></td>
<td></td>
</tr>
<tr>
<td>Application Server Instance Number</td>
<td>This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java. To find out the number on the host of the primary application server instance, look under the SAP directory <em>usr/sap/&lt;SAPSID&gt;/DVEBMGS&lt;nn&gt;</em>. The value &lt;nn&gt; is the number assigned to the SAP system.</td>
</tr>
<tr>
<td>Application Server Host</td>
<td>This is the host name of the relevant application server instance. To find out the host name, enter <em>hostname</em> at the command prompt of the host running the primary application server instance.</td>
</tr>
<tr>
<td>Communication User</td>
<td>This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.</td>
</tr>
<tr>
<td><strong>Using an External ABAP System – Parameters for the Application Server Java Connection:</strong></td>
<td></td>
</tr>
<tr>
<td>Administrator User</td>
<td>This is the name and password of the administrator user that you created on the external ABAP system.</td>
</tr>
<tr>
<td>Administrator Role</td>
<td>The role <strong>SAP_J2EE_ADMIN</strong> must exist on the external ABAP system.</td>
</tr>
<tr>
<td>Guest User</td>
<td>This is the name and password of the guest user that you created on the external ABAP system. The guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group <strong>Authenticated Users</strong> and have read access only.</td>
</tr>
<tr>
<td>Guest Role</td>
<td>The role <strong>SAP_J2EE_GUEST</strong> must exist on the external ABAP system.</td>
</tr>
</tbody>
</table>

Key Phrase for Secure Store Settings

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Phrase for Secure Store Settings</td>
<td>This is a random word or phrase that is used to encrypt the secure store. The Java EE engine uses this phrase to generate the key that is used to encrypt the data. The uniqueness of the phrase you use contributes to the uniqueness of the resulting key.</td>
</tr>
</tbody>
</table>
### Parameters

<table>
<thead>
<tr>
<th><strong>Parameters</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prerequisites</strong></td>
<td>Use a long key phrase that cannot be guessed easily. Use both uppercase and lowercase letters in the phrase and include special characters.</td>
</tr>
</tbody>
</table>

### Internet Communication Manager (ICM) User Management

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of webadm</td>
<td>The administration user webadm is created to use the web administration interface for Internet Communication Manager (ICM) and Web Dispatcher. SAPinst sets the master password by default. If required, you can choose another password. The length of the password must be between 5 and 128 characters.</td>
</tr>
</tbody>
</table>

### Host Agent

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of sapadm</td>
<td>The administration user sapadm is created to use central monitoring services. If this user does not already exist, SAPinst automatically creates it. SAPinst prompts you to enter either the password of the existing user or a new password for the user to be created.</td>
</tr>
</tbody>
</table>

### 3.2 Hardware and Software Requirements

You check that your hosts meet the hardware and software requirements for your operating system and the SAP instances.

**Caution**

If your hosts do not fully meet the requirements, you might experience problems when working with the SAP system.

**Prerequisites**

- Contact your OS vendor for the latest OS patches.
- Make sure that the host name meets the requirements listed in [SAP Note 611361](https://www.sap.com/).

**Process Flow**

1. Check the Product Availability Matrix at [http://service.sap.com/pam](http://service.sap.com/pam) for supported operating system releases.
2. Check the hardware and software requirements using:
   - The Prerequisite Checker:
3.2 Hardware and Software Requirements

- Standalone (optional) before the installation process
  For more information, see Running the Prerequisite Checker Standalone [page 32].
- Integrated in the installation tool (mandatory) as part of the installation process
  For more information, see Running SAPinst [page 49].

**Note**
For the most recent updates to the Prerequisite Checker, always check SAP Note 855498.

- The hardware and software requirements checklists for:
  - Additional application server instance [page 33]
  - Standalone host agent [page 34]

3. If you are installing a **production** system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:

  For more information about the SAP Quick Sizer and available sizing guides, see the Master Guide — SAP NetWeaver 7.0 at [http://service.sap.com/installnw70](http://service.sap.com/installnw70) Planning.

  - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
    - The set of applications to be deployed
    - How intensively the applications are to be used
    - The number of users

### 3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)

Before installing your SAP system, you can run the Prerequisite Checker in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances.

**Recommendation**

We recommend that you use **both** the Prerequisite Checker and the requirements tables for reference.

**Note**

When installing your SAP system, SAPinst automatically starts the Prerequisite Checker and checks the hardware and software requirements in the background.

**Prerequisites**

- You have prepared the Installation Master DVD on the required installation host [page 45].
**Procedure**

1. You start SAPinst [page 49].
2. On the Welcome screen, choose |<SAP System| Software Life-Cycle Options| Additional Preparation Tasks| Prerequisites Check |
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

   ![Note]

   For more information about each parameter, position the cursor on the parameter field and choose [F1] in SAPinst.

   When you have finished, the Parameter Summary screen appears summarizing all parameters you have entered. If you want to make a change, select the relevant parameters and choose Revise.

4. To start the Prerequisite Checker, choose Start.

**Result**

The Prerequisite Check Results screen displays the results found. If required, you can also check the results in file `prerequisite_checker_results.html`, which you can find in the installation directory.

### 3.2.2 Requirements for the Additional Application Server Instance

The additional application server instance host must meet the following requirements:

<table>
<thead>
<tr>
<th>Requirement Type</th>
<th>Requirement</th>
</tr>
</thead>
</table>
| Hardware         | - Suitable backup system  
|                  | - Minimum disk space:  
|                  |   - Additional application server instance (not including paging file):  
|                  |     - 2.5 GB (x86_64)  
|                  |     - 4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk.  
|                  |   - To check disk space:  
|                  |     1. Choose Start → All Programs → Administrative Tools → Computer Management → Disk Management |  
|                  |     2. Right-click the drive and choose Properties.  
|                  | - Minimum RAM: 1 GB  
|                  |   - To check RAM, in the Windows Explorer choose Help → About Windows |  
|                  | - Paging File Size:  
|                  |   - 1 times RAM plus 8 GB  
|                  |   - To check paging file size:  
|                  |     1. Right-click My Computer and choose Properties.  
|                  |     2. Choose Advanced → Performance Settings |
3.2.3 Requirements for the Host Agent as a Separate Installation

If you want to install the host agent separately, the installation host has to meet the following requirements:

**Hardware Requirements for the Host Agent**

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space:</td>
<td>Host agent: 80 MB</td>
<td>To check disk space:</td>
</tr>
<tr>
<td></td>
<td>Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB</td>
<td>1. Choose [Start] [All Programs] [Accessories] [Command Prompt]. ![Information Icon]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td>Minimum RAM:</td>
<td>40 MB</td>
<td>To check RAM:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the Windows Explorer choose ![Information Icon] Help ![Information Icon] About Windows ![Information Icon]</td>
</tr>
<tr>
<td>Paging file size:</td>
<td>500 MB</td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Choose [Start] [Control Panel] [System ![Information Icon]]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Choose Advanced (Windows Server 2003) or Advanced system settings</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Windows Server 2008).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Select ![Information Icon] Performance Settings ![Information Icon] Advanced ![Information Icon]</td>
</tr>
</tbody>
</table>
### 3.3 Checking the Windows File System

You need to check that you are using the Windows file system NTFS on hosts where you want to install the SAP system and database. NTFS supports full Windows security and long file names.
Note
You must use NTFS for an SAP system installation. Do not install the SAP directories on a FAT partition.

Procedure
1. Open the Windows Explorer.
2. Select the relevant disk
   The system displays the type of file system in use.
4. Check that the file system is NTFS.

3.4 Checking the Windows Domain Structure

Note
You do not need this step for a local installation.

In Windows, you can implement either of the following domain models for the SAP system:

- Extra domain
  In this model, the SAP system is embedded in its own domain, which is specially defined for SAP. A second domain exists for the user accounts.
  In Windows, the SAP domain and user domain must be incorporated in a domain tree. In this tree, the user accounts must form the root domain and the SAP domain must be a child domain of this.

- Single domain
  In this model, the SAP system and the user accounts are included in a single domain.

Prerequisites
- You are performing a domain installation.
- You are familiar with checking Windows domain structures. For more information, see the Windows documentation.

Caution
You cannot create local users and groups on the host that is used as domain controller. Therefore, we do not support running an SAP instance (including the database instance) on the host where the domain controller is installed.

Procedure
For a domain installation, we recommend that you check that all SAP system and database hosts are members of a single Windows domain. We recommend this for all SAP system setups.
3.5 Reducing the Size of the File Cache

Note
This step is not required if you use Windows Server 2008.

The Windows file cache competes directly with SAP programs for memory. Therefore, you need to adjust the file cache as described below.

Procedure
1. Choose Start Control Panel Network Connections Local Area Connections.
2. In the Local Area Connection Status dialog box, choose Properties.
3. In the Local Area Connection Properties dialog box, double-click File and Printer Sharing for Microsoft Networks.
4. Select Maximize data throughput for network applications.

Caution
If you cannot select File and Printer Sharing for Microsoft Networks, this option has not yet been installed. To install it, you need the Windows Server CDs.

5. To confirm your entries, choose OK.

3.6 Required User Authorization for the Installation

Although SAPinst automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a domain or local installation. If necessary, you have to ask the system administrator to grant the account the necessary authorization before you start the installation. If you attempt the installation with an account that does not have the required authorization, the installation aborts. This section informs you about the authorization required for a domain and a local installation.

Caution
Do not use the user <sapsid>adm for the installation of the SAP system.

Domain Installation
For a domain installation the account used for the installation needs to be a member of the local Administrators and the domain Admins group of the relevant domain. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.
If the SAP system is to be distributed across more than one machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

**Caution**

- If you install a distributed system as a local installation, this can lead to authorization problems for the operating system users `<sapsid>adm` and `SAPSE<SAPSID>`. It can also lead to problems with the transport directory, which is usually shared by several SAP systems. Therefore, we do not support a local installation for a distributed system. We recommend you to install a distributed system as a domain installation.
- If you still want to perform a local installation for a distributed system, make sure that:
  - You use the same password for the `<sapsid>adm` or the `SAPSE<SAPSID>` user on all hosts. The password for the `<sapsid>adm` and `SAPSE<SAPSID>` user can differ.
  - You use the same master password on all hosts.
  - All hosts belong to the same Windows work group.
- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.
- If for any reason, the account used for the installation is not a member of the domain `Admins` group, you can perform the installation with a domain user who is a member of the local `Administrators` group. However, the domain administrator has to prepare the system appropriately for you.

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain `Admins` group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain `Admins` group.

**Local Installation**

For a local installation the account used for the installation needs to be a member of the local `Administrators` group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local `Administrators` group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local `Administrators` group.
3.7 Performing a Domain Installation Without Being a Domain Administrator

You normally perform a domain installation of the SAP system with a user who is a member of the domain Admins group, as described in Required User Authorization for the Installation [page 37]. If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you. The domain administrator can perform the following steps either using SAPinst or manually:

1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Create the two new SAP system users <sapid>adm and SAPService<SAPSID>.
3. Create the two new SAP system users <sapid>adm and SAPSE<SAPSID>.
4. Add the users <sapid>adm and SAPSE<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.

Prerequisites

■ You must be domain administrator to perform the required steps.

■ Windows Server 2008 only:
  You must have installed the feature Remote Server Administration Tools as follows:
  2. In the Server Manager windows, select Features.

Creating the Required Uses and Groups Using SAPinst

On the host where the SAP system is to be installed, the domain administrator runs SAPinst [page 49] and chooses ➤ Software Life-Cycle Options ➤ Additional Preparation Options ➤ Operating System and Users ➤ to have the group and users created automatically.

Creating the Required Uses and Groups Manually

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin

1. Log on as domain administrator.
2. To start the Active Directory Users and Computers Console, choose:
   Start ➤ Control Panel ➤ Administrative Tools ➤ Active Directory Users and Computers ➤
Note

**Windows Server 2003 only:** If you cannot find *Active Directory Users and Computers*, start it as follows:

a) Choose **File** ➔ **Run** ➔ enter `mmc`

b) Choose **Console** ➔ **Add/Remove Snap-in...** ➔ **Add**

c) Select *Active Directory Users and Computers*. 

d) Choose **Add**

e) Choose **Close** ➔ **OK**

3. Right-click *Users in Tree*, and choose **New** ➔ **Group**.

4. Enter the following:

   *Group name*: `SAP_<SAPSID>_GlobalAdmin`

Note

Enter the `SAP_<SAPSID>_GlobalAdmin` group exactly as specified in the correct uppercase and lowercase.

5. Select the following:

   a) *Group scope*: Global 

   b) *Group type*: Security 

6. Choose **OK**.

Creating the New SAP System Users `<sapsid>adm` and `SAPSE<SAPSID>`

1. In *Active Directory Users and Computers Console*, right-click *Users in Tree* and choose: 

   **New** ➔ **User**

2. Enter the following:

Note

Enter the `<sapsid>adm` and `SAPSE<SAPSID>` user exactly as specified in the correct uppercase and lowercase.

<table>
<thead>
<tr>
<th>Field</th>
<th>Input for <code>&lt;sapsid&gt;adm</code></th>
<th>Input for <code>SAPSE&lt;SAPSID&gt;</code></th>
</tr>
</thead>
<tbody>
<tr>
<td>First name:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Initials:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Last name:</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Full name:</td>
<td><code>&lt;sapsid&gt;adm</code></td>
<td><code>SAPSE&lt;SAPSID&gt;</code></td>
</tr>
<tr>
<td>User logon name:</td>
<td><code>&lt;sapsid&gt;adm</code></td>
<td><code>SAPSE&lt;SAPSID&gt;</code></td>
</tr>
</tbody>
</table>

3. Choose **Next** and enter the following:

   *Password*: `<password>`
3.8 Preparing System i for Windows File System Access

You use this procedure to start the NetServer on System i. Windows uses NetServer to access IFS files on the System i where the central instance is running.

Procedure

The NetServer must be started automatically by adding one of the following commands to the startup program specified in the QSTRUPPGM system value (WRKSYSVAL QSTRUPPGM):
1. Log on to System i as a user that has authorization *IUSYSCFG, for example user QSECOFR.
2. Add one of the following commands:
   STRTCPSVR SERVER(*NETSRV) or
3.9 Installing the JDBC Driver

All database access from Java occurs through the JDBC API (Java Database Connectivity). Implementations of this are called JDBC drivers. The JDBC driver typically runs on the application server. If you install a Java additional application server instance on a Windows application server, you have to use the following JDBC driver:

- IBM Toolbox for Java JDBC Driver, also referred to as Toolbox JDBC Driver (part of license product 5722JC1). Toolbox JDBC Driver is a type 4 JDBC driver, which means that it is completely written in Java. It is therefore OS-independent. SAP certifies this driver for the following:
  - Local (two-tier) access from System i to a System i database
  - Remote (three-tier) access from any platform that was certified by SAP for Release 7.00 to a System i database

⚠️ Caution
You cannot use the IBM Developer Kit for Java JDBC Driver, also referred to as the Native JDBC Driver (part of license product 5722SS1, option 3) if you install Java additional application server instance on Windows application servers.

Prerequisites

- Make sure that the QUSER profile is enabled. To do so, log on as user QSECOFR and enter the following command:
  CHGUSRPRF USRPRF(QUSER)STATUS(*ENABLED)

- You need to start the DDM TCP/IP server and host servers after each IPL. To do so, proceed as follows:
  - To start TCP/IP, enter the following command:
    STRTCPSVR SERVER(*DDM)
  - To start host servers, enter the following command:
    STRHOSTSVR SERVER(*ALL)

⚠️ Note
You might want to start server jobs automatically after each IPL.
### Procedure

⚠ **Caution**

Toolbox JDBC Driver is installed with license product S722JC1. Follow the patch strategy described in the respective IBM Information APAR (VSR3 or higher) to get the current correction level of the supported System i JDBC drivers.

For the temporary patch of Toolbox JDBC Driver that is not supplied by a PTF but for example downloaded from an IBM web page, we recommend that you do not overwrite this product. Instead, proceed as follows:

1. Log on to your database server as user <SID>0FR.
2. Follow the download instructions in the respective Information APAR.
3. Extract the patch into an arbitrary directory on your database server, for example: `/sapmnt/jdbc/toolbox/jt400.jar`.
4. During the installation process, choose Toolbox JDBC Driver and specify the directory you have chosen above. In the above example, this is the following directory: `/sapmnt/jdbc/toolbox`.

### 3.10 Configuring Windows Transport Systems

Some command line functions of the transport program `tp.exe` do not work, for example shadow buffers. You have to correct the transport profile.

When using `tp.exe` from the command prompt, it is necessary to modify the transport configuration profile to indicate the transport directory in NETBIOS naming convention.

### Prerequisites

You have configured the domain controller in the Transport Management System (TMS). For more information, see *Configuring the Transport Management System* in the installation documentation of the System i installation guide for this product.

Modify the `TP_DOMAIN_<SID>.PFL` file on the System i in the `/sapmnt/trans/bin` directory.

### Access from Windows

```bash
\<SAPTRANSHOST>	rans\bin\sappet\trans\bin\ and then sappad.exe
```

*Sappad.exe* can be found in the SAP executable directory.

### Access from the SAP System

1. Call transaction STMS.
   - The *Transport Management System* screen appears.
2. Choose *System overview.*
The System Overview: Domain <DomainName> screen appears.
3. Double-click the system in which you want to perform the changes.
   The Display TMS Configuration: System <SID> screen appears.
4. Choose Transportool and then Display ↔ Change.
5. Add a line with the following information:
   - Parameter: wnt\transdir
   - Value: C:\<SAPTRANSHOST>\sapmnt\trans
6. To save your changes, choose Continue.
   To test your settings, execute:
   
   C:> tp showbuffer AM2
   pf=\as0039\saptext\trans\bin\TP_DOMAIN_AM2.PFL

**3.11 Preparing the SAP System Transport Host**

The transport host has a directory structure that is used by the SAP transport system to store transport data and metadata.
When you install an SAP system, SAPInst by default creates the transport directory on the primary application server instance host in \usr\sap\trans.
If you do not intend to use the directory structure of the system you are going to install, but want to use another new transport directory or an already existing transport directory, you need to prepare that transport host:
   - If the directory structure already exists, you must set up its security to allow the new system to write to it.
   - If it does not yet exist, you must create the core directory structure and a share to export it for other computers as well as set the security on it.

**Procedure**

1. If the transport directory does not yet exist, do the following:
   a) Create the directory \usr\sap\trans on the host to be used as the transport host.
   b) Share the \usr\sap directory on the transport host as SAPMNT and put the security settings for Everyone to Full Control for this share.
      This enables SAPInst to address the transport directory in the standard way as \\SAPTRANSHOST\SAPMNT\trans.
2. Grant Everyone the permission Full Control for the transport directory.
3.12 Preparing the Installation DVDs

This section describes how to prepare the installation DVDs, which are available as follows:

- You normally obtain the installation DVDs as part of the installation package.
- You can also download the installation DVDs from SAP Service Marketplace, as described at the end of this section.

1. Identify the required DVDs for your installation [page 13] as listed below.
   Keep them separate from the remaining DVDs as this helps you to avoid mixing up DVDs during the installation.

   **Note**
   - The media names listed in the following table are **abbreviated**.
   - You can find the Software Component Archives (SCAs) for the installation of SAP NetWeaver usage types on the NetWeaver Java DVD.

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional application server instance</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
<tr>
<td>Host Agent (Standalone)</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
</tbody>
</table>
2. Make the required installation media available on each installation host.

**Note**

Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.

For a standard system, you need to make all required installation media available on the single installation host.

Use one of the following methods to make DVDs available:
- **Before** the installation, copy DVDs manually to local hard disks.
- **During** the installation, use the SAPInst Media Browser dialog and copy the entire DVDs to the path you entered in the *Copy To* column.

**Caution**

- If you copy the DVDs to disk, make sure that the paths to the destination location of the copied DVDs do not contain any blanks.
- If you perform a domain installation and do not want to copy the DVDs but use network drives for mapping the installation DVDs, make sure that the `<sapsid>adm` user has access to the UNC paths of the network drives.

**Downloading Installation DVDs from SAP Service Marketplace (Optional)**

You normally obtain the installation DVDs as part of the installation package from SAP. However, you can also download installation DVDs from SAP Service Marketplace at:

http://service.sap.com/swdc

Download Installations and Upgrades ▶ Entry by Application Group ▶ <SAP solution> ▶ <SAP product> ▶ <SAP release> ▶ Installation and Upgrade ▶ <operating system> ▶ <database> ▶

**Note**

If you download installation DVDs, note that the DVDs might be split into several files. In this case, you have to reassemble the required files after the download.

**Caution**

To extract the downloaded SAR files make sure that you use the latest SAPCAR version, which you can find on SAP Service Marketplace at http://service.sap.com/swdc. You need at least SAPCAR 700 or SAPCAR 640 with patch level 4 or higher because older versions of SAPCAR can no longer unpack current SAR files. For more information, see SAP Note 212876.

1. Create a download directory on the host where you want to run SAPinst.
2. Identify all download objects that belong to one installation DVD according to one or both of the following:
3. Preparation

3.12 Preparing the Installation DVDs

- **Material number**
  - All download objects that are part of an installation DVD have the same material number and an individual sequence number:
  
  \(<\text{material\_number}>\_<\text{sequence\_number}>\)

  - Example
    
    51031387_1
    51031387_2
    ...

- **Title**
  - All objects that are part of an installation DVD have the same title, such as
    \(<\text{solution}>\_<\text{DVD\_name}>\_<\text{OS}>\) or \(<\text{database}>\_<\text{RDBMS}>\_<\text{OS}>\) for RDBMS DVDs.

3. Download the objects to the download directory.

4. Extract the individual download objects using SAPCAR, starting with the lowest sequence number – for example 51031387_1, then 51031387_2, and so on.

   During the download SAPCAR sets up the structure of the installation DVD.

- **Note**
  - SAPCAR asks if you want to replace existing files, for example `LABELIDX.ASC`. Always accept with **Yes**.
This page is intentionally left blank.
4 Installation

This section includes the installation steps that you have to perform for the:

- Additional application server instance
- Standalone host agent

Additional Application Server Instance(s)
You perform the following steps on each host where you install the additional application server instance(s).

1. You run SAPinst [page 49] to install the additional application server instance(s).
2. You continue with Post-Installation [page 59].

Installation Steps for Additional Components and Tools for SAP NetWeaver CE (Optional)

- You install additional components [page 54] for SAP NetWeaver Composition Environment, such as
  - Composition Tools
  - Adobe Document Services
  - Composite Voice
  - IDE Update Site

Standalone Host Agent

1. You run SAPinst [page 49] to install the Host Agent.
2. You continue with Post-Installation [page 59].

4.1 Running SAPinst

This procedure tells you how to install an SAP system with SAPinst. SAPinst includes a SAPinst GUI and a GUI server, which both use Java.

Note the following information about SAPinst:

- SAPinst normally creates the installation directory sapinst_instdir, where it keeps its log files, and which is located directly in the Program Files directory. If SAPinst is not able to create sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the environment variable TEMP.
**Recommendation**

We recommend that you keep all installation directories until the system is completely and correctly installed.

- SAPInst creates a subdirectory for each installation option called `<sapinst_instdir>\<installation_option_directory>`, which is located in `%ProgramFiles%\`.  
- The SAPInst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after SAPInst has stopped running. Directories called `sapinst_exe.xxxxx.xxxx` sometimes remain in the temporary directory. You can safely delete them. The temporary directory also contains the SAPInst Self-Extractor log file `dev_selfex.out`, which might be useful if an error occurs.

**Caution**

If SAPInst cannot find a temporary directory, the installation terminates with the error FCO-00058.

- During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPInst, GUI server, SAPInst GUI, and HTTP server. SAPInst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPInst. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service.

  In this case, open a command prompt and change to the required directory as follows:

  Enter the following command in a single line:

  ```
  sapinst.exe SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>
  GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
  GUISERVER_HTTP_PORT=<free_port_number_http_server>
  ```

  - To get a list of all available SAPInst properties, go to the directory (%TEMP%\sapinst_exe.xxxxx.xxxx), after you have started SAPInst, and enter the following command:

    ```
    sapinst.exe -p
    ```

  - If you want to terminate SAPInst and the SAPInst Self-Extractor, choose one of the following options:

    - Right-click the icon for the SAPInst output window located in the Windows tray and choose Exit.
    - Click the icon for the SAPInst output window located in the Windows tray and choose File ▶ Exit ▶

**Using SAPInst GUI**

The following table shows the most important functions that are available in SAPInst GUI:
### SAPinst GUI Functions

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>F1</td>
<td>Displays detailed information about each input parameter</td>
</tr>
<tr>
<td>Menu option</td>
<td>File</td>
<td>Stops the SAPinst GUI, but SAPinst and the GUI server continue running</td>
</tr>
</tbody>
</table>
| Menu option      | SAPinst Log Browser | Displays the Log Viewer dialog. This dialog enables you to access the following log files directly:  
  - Installation log (sapinst_dev.log)  
  - Log files from the SAPinst GUI server |
| Menu option      | SAPinst Cancel | Cancels the installation with the following options:  
  - Stop  
    - Stops the installation (SAPinst GUI, SAPinst and the GUI server) without further changing the installation files.  
    - You can restart and continue the installation later from this point.  
  - Continue  
    - Continues the installation |
| Message button   | Retry | Performs the installation step again (if an error has occurred) |
| Message button   | Stop  | Stops the installation without further changing the installation files.  
  - You can continue the installation later from this point. |
| Message button   | Continue | Continues with the option you have chosen before |

### Prerequisites

- You use an account with the required user authorization to install the SAP system with the SAPinst tool [page 37].
- You need at least 300 MB of free space in the installation directory for each installation option. In addition, you need 60-200 MB free space for the SAPinst executables.
- Make sure that you have defined the most important SAP system parameters as described in Basic SAP System Parameters [page 26] before you start the installation.
- Check that your installation host(s) meets the requirements for the installation option(s) that you want to install. For more information, see Running the Prerequisite Checker [page 32].

### Procedure

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD by double-clicking sapinst.exe from the following path:
SAPinst GUI starts automatically by displaying the *Welcome* screen.
However, if there is only one component to install, SAPinst directly displays the first input dialog without presenting the *Welcome* screen.

**Note**
If you want to use a virtual host name, start SAPinst as follows:

```
sapinst.exe SAPINST_USE_HOSTNAME=<virtual host name>
```

3. In the *Welcome* screen, choose the required SAPinst installation option from the tree structure. For more information, see *SAPinst Installation Options* [page 53].

**Note**
If you want to use the following installation options listed under *Software Life-Cycle Options*, you must start them **before** you start the installation of the SAP system:

- **Operating System Users and Groups**
  Choose this option, if the operating system users do not yet exist and you do not want to create them manually.

**Note**
Make sure that you have the *required user authorization* [page 37] for these accounts before you start the installation.

4. If SAPinst prompts you to log off from your system, log off and log on again.
SAPinst restarts automatically.

5. Follow the instructions in the SAPinst dialogs and enter the required parameters.

**Note**
For more information about the input parameters, position the cursor on the required parameter and press [F1].

6. To start the installation, choose *Start*.
SAPinst starts the installation and displays the progress of the installation. When the installation has successfully completed, SAPinst shows the dialog *Execution of <Option_Name> has been completed successfully*.

7. We recommend deleting all files in the directory `%userprofile%\sdsgui\`.

**More Information**
- *Interrupted Installation with SAPinst* [external document]
- *Entries in the Services File Created by SAPinst* [external document]
- *How to Avoid Automatic Logoff by SAPinst* [external document]
- *Troubleshooting with SAPinst* [external document]
4.2 SAPinst Installation Options

This section provides information about the following in SAPinst:

- **Software Life-Cycle Options**

  **Note**

  - Choose the required installation options from the tree structure **exactly** in the order they appear for each system variant.
  - If required, install an additional application server instance for a standard system (all instances on one host) or distributed system by choosing [SAP Life-Cycle Options] > Additional Application Server Instance > Additional Application Server Instance.
  - If required, install additional CE components by choosing [SAP Life-Cycle Options] > Additional CE Components > Additional CE components.
  - If required, install SAP Memory Analyzer by choosing [SAP Life-Cycle Options] > SAP Memory Analyzer > SAP Memory Analyzer.

**Software Life-Cycle Options**

You use the options located in this folder to perform the following tasks or to install the following components:

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
</table>
| Additional Preparations | Host Agent  
Choose [Additional Preparations] > Host Agent > Host Agent to install the host agent with the profiles SAPSystem=99 and SAPSystemName=SAP.  
The host agent contains all of the required elements for centrally monitoring any host.  
Normally you do not need to install a standalone host agent, because it is automatically installed during the installation of all SAP NetWeaver components, except TREX.  
You only need to install a standalone host agent when:  
- You want to centrally monitor a host that does not have an SAP component.  
- You want to perform an upgrade to SAP NetWeaver.  
| Operating system users and groups  
Creates all operating system users for your SAP system if they do not yet exist |

  **Caution**

  - Perform this SAPinst option **before** you start the installation of your SAP system.  
  - Make sure that you have the **required user authorization** [page 32] for these accounts before you start the installation.
  - Prerequisites check
### 4.3 Installing Additional Components (Optional)

You can install the following additional components:

- Composition Tools
- Adobe Document Services (if available for your platform)
- Composite Voice
- IDE Update Site

**Prerequisites**

You need to fulfill the same hardware and software requirements as for your already installed production system plus an additional 2 GB RAM.

The Composition Tools and Composite Voice component make use of the Visual Composer. Visual Composer is a Web browser based tool to model user interfaces. To run Visual Composer, the following programs must be installed on the client computer from which you access Visual Composer:

- Microsoft Internet Explorer 6.0 SP1 or higher
- Adobe SVG Viewer 3.0
- Microsoft XML Parser 4.0 or higher
4.3 Installing Additional Components (Optional)

Note

Before installing additional components, you need to stop all application servers manually.
Before installing additional components and in the case that you made changes to the default
template settings, see SAP Note 953763.

Procedure

Note

When installing from a network share make sure that everyone has read access to this share. The
installation routine creates users such as $<sid>adm$ (for example, co1adm). During the installation
SAPinst does a user switch to this user. If the newly created user does not have permissions to the
network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPinst [page 49].
3. In the Welcome screen, choose $\Rightarrow$ SAP NetWeaver CE Productive System $\Rightarrow$ Software Life-Cycle Options $\Rightarrow$
   Additional CE Components $\Rightarrow$ Install Additional Components $\Rightarrow$.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have
to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have
to respond to all prompts.

Note

If you want to install the offline documentation for SAP NetWeaver CE, you need to choose
Custom mode.
After the installation, you can access the offline documentation by choosing $\Rightarrow$ Start $\Rightarrow$ All Programs $\Rightarrow$
SAP NetWeaver Composition Environment $\Rightarrow$ <SAPSID> $\Rightarrow$.

5. Follow the screens and enter the required parameters.

Note

For more information about the input parameters and information about restrictions for
passwords, position the cursor on the required parameter and press $\mathbf{F1}$.

After you have entered all requested input parameters, SAPinst displays the Parameter Summary
screen. This screen shows both the parameters that you entered and those that SAPinst set by
default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of
the installation. When the installation has successfully been completed, SAPinst shows the dialog
Execution of $<\text{Option}_\text{Name}>$ has been completed successfully.
4.4 Installing SAP Memory Analyzer (Optional)

SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive. New and innovative analysis techniques support the user with a fast and powerful feature set. The tool (Eclipse RCP application) was developed to analyze real productive heap dumps, which tend to get enormous in size with hundreds of millions of objects. Performance, low resource consumption and especially the newly developed innovative analysis techniques make it a helpful tool, even to small application heap dumps. You can install SAP Memory Analyzer as an additional tool.

Procedure

Note

When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as $<\text{sid}>\text{adm}$ (for example, $ce1\text{adm}$). During the installation SAPInst performs a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPInst [page 49].
3. In the Welcome screen, choose $\text{SAP NetWeaver CE Productive System} \rightarrow \text{Software Life-Cycle Options} \rightarrow \text{SAP Memory Analyzer} \rightarrow \text{Install SAP Memory Analyzer}.$
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

Note

If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode. After the installation, you can access the offline documentation by choosing $\text{Start} \rightarrow \text{All Programs} \rightarrow \text{SAP NetWeaver Composition Environment} \rightarrow <\text{SAPSID}>.$
5. Follow the screens and enter the required parameters.

Note

For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog "Execution of <Option_Name> has been completed successfully."
This page is intentionally left blank.
5 Post-Installation

This section includes the post-installation steps that you have to perform for the:

- Additional application server instance
- Standalone host agent

**Additional Application Server Instance**

1. You check whether you can log on to the additional application server instance [page 60].
2. You perform a full system backup [page 71].
3. If you want or need to implement the E2E Root Cause Analysis scenario, you have to perform post-installation steps for the Diagnostics Agent [page 72] on your central instance and/or dialog instance(s).

**Standalone Host Agent**

You perform the post-installation steps for the Host Agent [page 66].

### 5.1 Configuring the Windows Server 2008 Firewall

As of Windows Server 2008, the Windows Firewall is turned on by default. It is configured to allow only a small set of Windows-specific inbound IP connections. Outbound connections by default are not limited to rules and are therefore not restricted by the firewall.

**Note**

- The default firewall settings are valid for the out-of-the-box installation of Windows Server 2008 and apply to local policies. For domain policies that override local policies, other rules might apply.
- To disable the Windows firewall temporarily, proceed as follows:
  2. Right-click Windows Firewall with Advanced Security and choose Properties.
  3. To turn off the firewall, choose the relevant profile (in most cases Domain Profile) and set the Firewall state to Off.
  4. To turn on the firewall again, set the Firewall state to On.

For the SAP system to operate, you might have to configure the Windows firewall and define a set of Inbound Rules for the TCP/IP port numbers that are used by your system.
For more information about the port numbers used, see the documentation TCP/IP Ports Used by SAP Applications at:

http://service.sap.com/security

Ports listed with the default value *Not active* in this document are not configured.

**Procedure**

This procedure describes how to set *Inbound Rules* for the ports of an installed ABAP server that was installed with instance number 00.

1. Choose **Start** ➤ **Administrative Tools** ➤ **Windows Firewall with Advanced Security**.
2. Right-click *Inbound Rules* and choose **New Rule**.
   The **New Inbound Rule Wizard** starts.
3. For *Rule Type*, select *Port* and choose **Next**.
4. For *Protocol and Ports*, select port type *TCP* or *UDP* depending on the port type used.
   Select *Specific local ports*, and enter the port numbers for which you want to apply the new rule.
   Choose **Next**.
5. For *Action*, select *Allow the connection*, and choose **Next**.
6. For *Profile*, keep *Domain*, *Private* and *Public* selected, and choose **Next**.
   For more information, see the link *Learn more about profiles* on this screen.
7. Enter the *Name*, for example **SAP ABAP Server 00**, and *Description* for the new rule.
8. Choose **Next**.
9. Choose **Finish** to save the rule.
   The new inbound rule appears in the *Inbound Rules* list. To modify the settings, right-click on the rule and choose *Properties*.

**Note**

If you want to use, for example, a different IP scope for port 50013, which is used by the connection SAP Start Service – SAP Management Console, you can restrict the IP access to a small number of SAP Administrators. Then delete this port from the SAP ABAP Server 00 rule and create a new rule for port 50013 with a more restrictive scope.

**5.2 Logging On to the Application Server**

You need to check that you can log on to the application server using the following standard users:
5.3 Ensuring User Security

You need to ensure the security of the users that SAPinst creates during the installation. For security reasons, you also need to copy the installation directory to a separate, secure location – such as a DVD – and then delete the installation directory.
5.3 Ensuring User Security

**Recommendation**

In all cases, the user ID and password are only encoded when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC. For more information, see the SAP Library [page 10]:

Function-Oriented View  ➤ Security ➤ Network and Transport Layer Security ➤

**Caution**

Make sure that you perform this procedure **before** the newly installed SAP system goes into production.

**Prerequisites**

If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.

**Procedure**

For the users listed below, take the precautions described in the relevant SAP security guide, which you can find on SAP Service Marketplace at [http://service.sap.com/securityguide](http://service.sap.com/securityguide):

Changing Passwords of Created Users

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Administrator Account</td>
<td>&lt;sid&gt;adm</td>
</tr>
<tr>
<td>SAP Service Account</td>
<td>SAPSE&lt;SID&gt;</td>
</tr>
</tbody>
</table>

Host Agent User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator You do not need to change the password of this user after the installation. This user is for administration purposes only.</td>
</tr>
</tbody>
</table>
Note
You can set up Java standalone users with the SAP User Management Engine (UME) in one of the following ways:

- With the users stored in an external ABAP system — see the first table below
- With the users stored in the database — see the second table below

The next two tables show these ways of managing the users.

### SAP System Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>This user's password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the Config Tool. For more information, see Checking the SAP Java Documentation [page 67].</td>
</tr>
<tr>
<td></td>
<td><img src="Image" alt="Recommendation" /> We recommend that you call the user J2EE_ADM_&lt;SAPSID_Java_System&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The maximum length is 12 characters.</td>
<td></td>
</tr>
<tr>
<td>Guest</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Lock this user for interactive logon.</td>
</tr>
<tr>
<td></td>
<td><img src="Image" alt="Recommendation" /> We recommend that you call the user J2EE_GST_&lt;SAPSID_Java_System&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The maximum length is 12 characters.</td>
<td></td>
</tr>
<tr>
<td>Communication user for Application Server Java</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Specify this user as a Communications user and not as a dialog user. This user exists at least in the SAP system client that you specified during the installation.</td>
</tr>
<tr>
<td></td>
<td><img src="Image" alt="Recommendation" /> We recommend that you call the user SAPJSF_&lt;SAPSID_Java_System&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The maximum length is 12 characters.</td>
<td></td>
</tr>
</tbody>
</table>

### SAP System Users Stored in the Database

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The name that you gave this user during the installation or the default name Administrator</td>
<td>This user's password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool.</td>
</tr>
</tbody>
</table>

05/16/2008
5.4 Creating Symbolic Links on Windows Server 2008 for Application Servers

With Windows Server 2008 you can create symbolic links for additional application server instances to simplify their administration.

Symbolic links for application servers let you access from your local host the SYS directory that is located on the global host, without having to specify its UNC path. Instead you can browse, for example in the Windows explorer on your local host to the SYS directory and its subdirectories on the global host.

Procedure
To create symbolic links, perform the following steps:

1. In the Start menu, right-click on Command Prompt and choose Run as administrator.
2. Enter the following command in a single line:
   ```
   mklink /d <localdisk>:\usr\sap\<SAPSID>\SYS  \\<sapglobalhost>\sapmnt\<SAPSID>\SYS
   ```

   ![Note]
   Enter a blank before `\\<sapglobalhost>`

3. If you use a central transport directory, you can also create the following link:
   ```
   mklink /d <localdisk>:\usr\sap\trans  \\<trans_dir_host>\sapmnt\trans
   ```

   ![Note]
   The transport directory host `<trans_dir_host>` and the `<sapglobalhost>` can be identical.

![Caution]
The command `mklink` creates the link without checking whether the link target exists or is accessible. If the link does not work after you created it, make sure that it exists and check the accessibility of the UNC path.

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guest</td>
<td>The name that you gave this user during the installation or the default name Guest</td>
<td>Lock this user for interactive logon.</td>
</tr>
</tbody>
</table>

For more information, see Checking the SAP Java Documentation [page 67].
5.5 Configuring the Transport Management System

You have to perform some steps to be able to use the Transport Management System.

Procedure

1. Perform post-installation steps for the transport organizer:
   a) Call transaction SE06.
   b) Select Standard Installation.
   c) Choose Perform Post-Installation Actions.
2. Call transaction STMS in your SAP Solution Manager system to configure the domain controller in the Transport Management System (TMS).

Result

You can now perform Java transports in the TMS of your SAP Solution Manager system.

More Information

For more information, see the SAP Library [page 10]:
- Function-Oriented View
- Application Server ABAP
- Administration Tools for AS ABAP
- Change and Transport System

5.6 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the EarlyWatch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP. For more information, see SAP Service Marketplace at http://service.sap.com/remoteconnection.

5.7 Applying the Latest Kernel and Support Packages

You have to apply the latest kernel and Support Packages for your SAP system from SAP Service Marketplace.

⚠️ Caution

Before you apply support packages, make sure that you read the release notes for your SAP system. You can find these at http://service.sap.com/releasenotes. The release notes might include information about steps you have to perform after you have applied the support packages.

You can use Java Support Package Manager (JSPM) to apply both the latest ABAP+Java or Java kernel and Java support packages.
JSPM is a Java standalone tool that you can use with SAP NetWeaver 7.1. JSPM uses the Software Deployment Manager (SDM) to apply support packages and patches and to deploy software components.


**Procedure**

1. Apply the latest kernel.
   We recommend that you replace the installed kernel with the latest kernel from SAP Service Marketplace. In particular, you should replace the installed kernel if:
   - You installed the kernel executables locally on every host.
   - Your primary application server instance host runs on a different operating system than your additional application server instance host.
   For more information about how to download a kernel, see SAP Note 19466.
   To exchange the ABAP+Java kernel, you can use Java Support Package Manager (JSPM).

2. Apply Support Packages.
   a)  
   b) Alternatively, you can download Support Packages from:
   
   [http://service.sap.com/patches](http://service.sap.com/patches)
   
   c) Apply the Java Support Packages to your SAP system with the help of the Java Support Package Manager (JSPM).
   
   For more information about the availability of Support Packages, see:
   [http://service.sap.com/ocs-schedules](http://service.sap.com/ocs-schedules)
   

### 5.8 Post-Installation Steps for the Host Agent

You have to perform the following steps on each host where the host agent is installed. This applies whether the host agent is installed on a host within the SAP system or standalone on another host.

**Procedure**

1. You check whether the installed services are available as follows:
5.9 Checking the SAP Java Documentation

Here you can find information in the SAP Library about the configuration of Application Server Java (AS Java) and about SAP Java technology.

Procedure

1. Choose the following in the SAP library [page 10]:
   - Function-Oriented View ➤ Application Server Java ➤ AS Java (Application Server Java)

2. Check the following documentation for information relevant to running your Java system:

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>➤ Application Server Infrastructure ➤ Architecture of the SAP NetWeaver Application Server ➤ Architecture of AS Java</td>
<td>This documentation provides an overview of the architecture of the Application Server Java (AS Java). It contains information on: ➤ Java cluster architecture ➤ Application Server Java (AS Java) system architecture ➤ Zero Administration (technical configuration within AS Java)</td>
</tr>
<tr>
<td>Manual</td>
<td>Contents</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 6. Application Server Java  Administration ➔                        | This documentation describes how to administer the SAP system, focusing on AS Java. It contains information on:   **Administration Tools**  
  * SAP Management Console  
    - The SAP Management Console (SAP MC) provides a common framework for centralized system management. It lets you monitor and perform basic administration tasks on the SAP system centrally, thus simplifying system administration.  
  * SAP NetWeaver Administrator  
    - SAP NetWeaver Administrator is a Web-based tool for administration and monitoring that offers a single entry point to configure, administer, and monitor your SAP NetWeaver system, its components, and the applications running on it.  
  * Config Tool  
    - The Config Tool provides offline configuration of the SAP NetWeaver Application Server Java (AS Java) instances. It lets you modify the properties of all services, managers, and applications. In addition, it enables you to manage log configurations offline, add filters, and edit the JVM parameters.  
  * Administration Using Telnet  
  * SAP Java Virtual Machine (SAP JVM)  
  * The Startup Framework for AS Java  
  * Administration Functions for Information Lifecycle Management |
| 6. Application Server Java  Identity Management of the Application Server Java ➔ | Identity Management of the SAP NetWeaver Application Server (AS Java) enables you to manage users and roles for access to applications of the AS Java and the data, which the applications require. The user management engine (UME) provides identity management as a service of the AS Java. This documentation contains information on:  
  * User Management Engine  
  * Authorization Concept of the AS Java  
  * Configuring Identity Management  
  * Administration of Users and Roles                                                                                           |
| SAP High Availability                                                  | This documentation contains information on:  
  * Cluster and Load Balancing (AS-Java)  
  * Single points of failure for SAP NetWeaver AS Java                                                                        |
| Security  System Security ➔                                          | This documentation contains information on additional system security functions for AS Java.                                                                                                                                  |

### 5.10 CE-Specific Post-Installation Activities

This section describes the steps that you have to perform after the installation has finished successfully.
Running the Configuration Wizard (Optional)

Note
You can run the configuration wizard only once and only directly after installing and patching your SAP system.

After SAPinst has finished, run the configuration wizard to apply automated configuration tasks to your system. For SAP NetWeaver CE, you need to run the following configuration tasks, depending on the installed components:

- Configuration of Services Registry Webservice Destinations
- Configuration and Mirroring of local NWDS Update Site
- Initial setup ADS in CE (if ADS is available on your platform)
- Change Management Service (CMS): Create an Application Skeleton
- Change Management Service (CMS): Modify a Software Component

For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

Enabling Adobe Document Services
If you have installed SAP NetWeaver Composition Environment with the Adobe Document Services add-on on a Windows platform, you must complete the following post-installation steps to enable the add-on. In case you have installed an AS Java cluster, apply the procedure to the central host, as well as to all hosts where additional application server instances are running.

1. Using the SAP Management Console, stop the AS Java system.
2. From the Start menu, open » Control Panel » Administrative Tools » Computer Management » Services and Applications » Services ».
3. Select SAP<SID>_<Instance_Number> (for example, SAPCE1_00) and open Properties from the context menu.
4. On the Log On tab page, enable the Local System account indicator.
5. Repeat the above steps for the second SAP<SID>_<Instance_Number> service that you see in the list.
6. Start the AS Java system.

Adobe LiveCycle Designer
For more information about how to install and configure the Adobe LiveCycle Designer see SAP Note 962763.
Enabling Services Registry

You must apply additional configuration steps to enable Services Registry after you have installed an SAP NetWeaver Composition Environment system containing the following components:

- Java Application Server and Composition Platform
- Java Application Server and Adobe Document Services

To enable Services Registry, you must apply the following configuration template to your system:

```
CE_Complete_Stack_production_full
```

**Note**

For more information about what configuration templates are available, see Configuration Templates [page 73].


See also


Configuring the Portal in SAP NetWeaver CE

After installing the portal in SAP NetWeaver CE, a number of deactivated or irrelevant tools are displayed in the UI. To display the correct portals tools for CE, proceed as follows:

1. Open a browser and log on to your portal as an administrator.
2. In the same browser session, enter the following URL:


   where `<host>` is the host name of your server and `<httpport>` is the port number of your server.
3. In the Portal Mode Configuration Tool, choose *Activate Development Mode* to restore the portal tools and content that are assigned to the development mode.
4. Restart or refresh your browser.
5. In the SAP Management Console, restart the server.

You may then continue with the mandatory and optional configuration steps as described in [http://help.sap.com/nwce](http://help.sap.com/nwce) SAP NetWeaver Composition Environment Library 》 Administrator’s Guide 》 Configuration of SAP NetWeaver Composition Environment 》 Configuration for CE Additional Components 》 Configuring the Portal.
Changing the Password for the Internet Communication Manager (ICM)

You can monitor and manage the Internet Communication Manager (ICM) from the command line program.
After the installation of your SAP NetWeaver CE system has successfully finished, you need to change
the ICM password manually. To do so, proceed as follows:
1. Log on at operating system level to the computer where the ICM is running.
2. Start the program icmon with `icmon -a profile=<instance_profile>` to maintain the
authentication file (default: authfile.txt).
3. Choose `a` to add a user.
4. Choose `c` to change the password of the existing user.
5. Choose `s` to save your settings.

Further Configuration Steps

After installing your SAP NetWeaver CE system and performing the post-installation steps to get the
system up & running, you may need to perform further configuration steps.
Refer to the following documentation to proceed with your tasks:

  It contains information about how to configure and administer your system.
guidelines for developing applications using the SAP NetWeaver CE.

Note

The SAP NetWeaver CE documentation is also available offline as a part of your installation. To access
it, choose [Start] [All Programs] [SAP NetWeaver] [Composition Environment 1.0] [Documentation].

5.11 Performing a Full System Backup

You must perform a full system backup after the configuration of your SAP system. If required,
you can also perform a full system backup after the installation (recommended). In addition, we
recommend you to regularly back up your database.

Prerequisites

- You are logged on as user `<sapsid>adm`.
- You have shut down the SAP system and database.
5.12 Post-Installation Steps for the Diagnostics Agent

To implement the E2E Root Cause Analysis scenario, you have to configure the Diagnostics Agent.

Prerequisites
You have installed an AS Java central instance or dialog instance.

Procedure
Plan the implementation of the SAP Solution Manager Diagnostics Agent as described in the Root Cause Analysis Installation and Upgrade Guide, which you can find at http://service.sap.com/diagnostics.
6 Additional Information

Here you can find additional information about the installation of your SAP system. There is also information about how to delete an SAP system.

- Additional Information about SAPinst [page ]
- Starting and Stopping the SAP System [page 78]
- SAP System Security on Windows [page 79]
- Automatic Creation of Accounts and Groups [page 80]
- Deleting an SAP System [page 82]

6.1 Transporting Self-Developed Software Component Archives (SCA) into the System

Prerequisites
You have developed your own Software Component Archives (SCA) and want to transport them into your SAP NetWeaver CE system.

Procedure
To transport your SCAs to the SAP NetWeaver CE system, proceed as follows:

1. Download the update file from [http://service.sap.com/swdc] [Download] [Support Packages and Patches] [Entry by Application Group] [SAP NetWeaver] [SAP NETWEAVER] [SAP NETWEAVER CE 7.1] [Support Package Stacks 4]
2. From an empty directory, run the update tool update<ID>.exe.

Note
If the tool displays descriptions such as Applying Support Packages, you can ignore them.

3. In the dialog screens, specify the directory where your SCAs are located.
4. Follow the on-screen instructions.

6.2 Configuration Templates

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates
are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options. The following table provides information about the available templates with SAP NetWeaver Composition Environment. In the template name, replace the <system_mode> parameter by development (for the templates relevant to systems installed in development mode) or production (for the templates relevant to systems installed in productive mode).

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Selected Installation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Java_EE_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation</td>
</tr>
<tr>
<td>CE_Composition_Environment_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation</td>
</tr>
<tr>
<td>CE_Adobe_Document_Service_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Adobe Document Services Add-on Installation</td>
</tr>
<tr>
<td>CE_Composite_Voice_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Voice Add-on Installation</td>
</tr>
<tr>
<td>CE_Complete_Stack_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation + Adobe Document Services Add-on Installation + Voice Add-on Installation</td>
</tr>
</tbody>
</table>

If your selection cannot be mapped to one of the combinations in the above table, the template CE_Complete_Stack_<system_mode>_full is applied. It starts all applications and services needed to run the complete stack.

You can manually apply a different configuration template if you want to switch to another installation option. For example, by changing from template CE_Complete_Stack_<system_mode>_full to CE_Java_EE_<system_mode>_full, you achieve shorter startup times and less memory consumption, but also less functionality since not all applications and services are running.


**Note**

Make sure that you do not apply a development template to a productive system or vice versa.

### 6.3 Uninstalling SAP NetWeaver Composition Environment

You have to uninstall all components of the SAP NetWeaver Composition Environment separately. You can uninstall your SAP NetWeaver CE system in different ways.
Uninstalling SAP NetWeaver CE
Choose [Start] → [Control Panel] → [Add / Remove programs] → [SAP System <SAPSID>].

Uninstalling SAP NetWeaver CE Using SAPinst
1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD as described in the section Installing SAP
   NetWeaver Composition Environment.
3. In the Welcome screen, choose Uninstall SAP System or Single Instances from the tree structure.
4. Follow the on-screen instructions.

Uninstalling the SAP Management Console
Since all SAP systems use the SAP Management Console, there is no uninstallation option for the
SAP Management Console with SAPinst. If you are sure that you do not need the SAP Management
Console any more, you can remove it using [Start] → [Control Panel] → [Add / Remove programs].

6.4 SAP Directories

This section describes the SAP directories that SAPinst creates during the installation.
SAPinst automatically creates the following directories during the installation:

- `\usr\sap`

  This directory is created on the:

  - **Global** host and shared with the network share `sapmnt`
    
    The global host is the host where the SCS and primary application server instance is installed.
    On global hosts, the `\usr\sap` directory contains general SAP software, global and local
    (instance-specific) data.
    
    For this, SAPinst creates the global directory `\usr\sap\<SAPSID>\SYS`, which physically exists
    only once for each SAP system. It consists of the following subdirectories:
    
    - `global` – contains globally shared data
    - `profile` – contains the profiles for all instances
    - `exe` – contains executable replication directory for all instances and platforms

  - **Local** host and shared with the name `saploc`.
    
    On local hosts, the `\usr\sap\<SAPSID>\<instance_name>` directory contains copies of the SAP
    software and local (instance-specific) data.

Note

Since SAP traces for the instance are created in `\usr\sap`, make sure there is sufficient space
available in this directory. Changes in SAP profiles can also affect the disk space.
Note

The executables on the local host are replicated from those on the global host every time the local instance is started. The SAP copy program `sapcpe` compares the binaries in the `<platform>` directory on the global host and the binaries in the `exe` directory on the application server. If the binaries in the `exe` directory are elder than those in the `<platform>` directory, `sapcpe` replaces them with the newer version of the global host.

Other application servers access the global data using the Universal Naming Convention (UNC) path `\\<SAPGLOBALHOST>\sapmnt`. The SAP programs access their instance-specific data with the UNC path `\\<SAPLOCALHOST>\saploc`. If the UNC path points to a local directory, the local path (and not the UNC path) is used to access the directory.

The parameters `SAPGLOBALHOST` and `SAPLOCALHOST` have the same values on the global host.

- `\usr\sap\trans`

  The transport directory contains SAP software for the transport of objects between SAP systems. SAPinst by default creates it on the `SAPGLOBALHOST`.

  If you want to have it created on another host, or if you want to use an already existing transport host of your SAP system landscape, you can specify another host during the installation. In this case, you have to prepare that host to allow the new SAP system to use it as transport host. For more information, see *Preparing the SAP System Transport Host* [page 44].

**Directory Structure**

The following figures show how the physical directory `\usr\sap` is shared on the global host in a standard and in a distributed system. In both cases, the UNC paths are used as follows:

- `\\<SAPGLOBALHOST>\sapmnt` to access global directories
- `\\<SAPLOCALHOST>\saploc` to access local instance-specific data

Note

There are the following instance names available in an SAP system:

- Central services instance: `SCS<No>`
- Primary application server instance: `J<Instance_Number>`
- Additional application server instance: `J<Instance_Number>`.
Figure 6: Directory Structure on the Global Host in a Standard (Central) Java System

Figure 7: Directory Structure for a Distributed Java System
6.5 Starting and Stopping the SAP System

You use this procedure to check that you can start and stop the SAP system after the installation with the SAP Microsoft Management Console (SAP MMC).

With a newly installed SAP MMC you can start or stop installed SAP instances locally on the host that you are logged on to. If the SAP MMC is configured for central system administration, you can start or stop the entire system from a single host.

![Note](image)

For more information, see the SAP Library [page 10]:
- Function-Oriented View ➤ Application Server ABAP ➤ Administration Tools for AS ABAP ➤ Monitoring in the CCMS ➤ SAP Microsoft Management Console: Windows

Prerequisites
- You have logged on to the SAP system host as user `<sapsid>adm`.
- You have checked the settings for VM parameters as described in SAP Note 723909.

Procedure

1. Start the SAP MMC on the SAP system host by choosing ➤ Start ➤ All Programs ➤ SAP Management Console ➤.
2. Right-click the SAP system node and choose Start or Stop.
   All instances listed under the system node start or stop in the correct order.
3. If the SAP system is installed on multiple hosts (distributed system), you have the following options to start or stop your system:
   You have the following options to start or stop your system:
   - You start or stop the SAP instances using the SAP MMC on each host.
   - You add the remote instances to the SAP MMC configuration to start or stop all instances from a single SAP MMC.
   To do so, you configure the SAP MMC manually. For more information, see _Changing the Configuration of the SAP MMC_ in the SAP MMC documentation.

![Note](image)

You can also start and stop a UNIX system with the SAP MMC.
6.6 SAP System Security on Windows

In a standard SAP system installation, SAPinst automatically performs all steps relevant for security. Although SAPinst makes sure that the system is protected against unauthorized access, you must still check that no security breaches can occur.

For central and straightforward administration of the SAP system, you have to install distributed SAP systems with multiple application servers in a Windows domain. This section describes the user accounts and groups that SAPinst creates during a domain installation and shows how these are related to the SAP directories.

User Accounts
SAPinst creates the following accounts for SAP system administration:

- `<sapsid>adm`
  This is the SAP system administrator account that enables interactive administration of the system.
- `sapadmin`
  This is the user account that is required to start the SAP system. It has the local user right to log on as a service.
- `sapadm`
  This is the user for the SAP host agent. It is a member of the local Administrators group.
  The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator.

Groups
SAPinst creates the following groups during a domain installation:

- `SAP_<SAPSID>_GlobalAdmin`
  This global group is a domain-level SAP administration group for organizing SAP system administrators. The only function of a global group is to group users at the domain level so that they can be placed in the appropriate local groups.
- `SAP_<SAPSID>_LocalAdmin`
  Only local groups are created and maintained on an application server. A local group can only be given permissions and rights to the system where it is located. The system is part of a particular domain, and the local group can contain users and global groups from this domain.
- `SAP_LocalAdmin`
  This group is created on all hosts, but is particularly important for the transport host. Members of the group have full control over the transport directory (`\usr\sap\trans`) that allows transports to take place between systems.

SAP Directories
SAPinst protects the SAP directories under `\usr\sap\<SAPSID>` by only granting the group `SAP_<SAPSID>_LocalAdmin` full control over these directories.
The following graphic illustrates the user accounts and groups created by SAPinst in a system infrastructure consisting of two SAP systems.

**Figure 8: User Groups and Accounts**

![Diagram showing user groups and accounts]

**Note**

An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP system, only the following are members of all SAP system object ACLs:

- Local group SAP_<SAPSID>_LocalAdmin
- Group Administrators
- Account SYSTEM

### 6.7 Automatic Creation of Accounts and Groups

SAPinst automatically creates the accounts and groups required for the secure operation of the SAP system with Windows [page 79] during the installation.

**Features**

The following figures show the steps that SAPinst performs to create the users and groups and assign the required rights to SAP directories.
**Figure 9:** Creating Users and Groups

<table>
<thead>
<tr>
<th>Creation of Accounts</th>
<th>SAP Administrator &lt;sapsid&gt;adm</th>
<th>SAP Service Account SAPService&lt;sapsid&gt;</th>
<th>SAP Host Agent Account sapadm</th>
</tr>
</thead>
</table>

**Creation and Modification of Global Group in the Domain**
- Creation of global group SAP_<SAPSID>GlobalAdmin
- Addition of <sapsid>adm and SAPService<sapsid> to group SAP_<SAPSID>_GlobalAdmin
- Addition of <sapsid>adm to the local Administrators group
- Addition of <sapsid>adm to the Windows domain user groups

**Creation and Modification of Local Group on Each Application Server**
- Creation of the local group SAP_<SAPSID>_LocalAdmin on the application server
- Addition of the global SAP_<SAPSID>_GlobalAdmin to the local group SAP_<SAPSID>_LocalAdmin on the application server
- Creation of the local group SAP_LocalAdmin on the application server
- Addition of the global group SAP_<SAPSID>_GlobalAdmin to the local group SAP_LocalAdmin on the transport host

**Figure 10:** Assigning Rights to SAP Directories

For **Administrators and SAP_LocalAdmin groups**
Assignment of Full Control over:

- usr
- usr\sap
- usr\sap\trans
- usr\sap\prfclg

For **Administrators and SAP_<SAPSID>_LocalAdmin groups**
Assignment of Full Control over:

- usr\sap\<SAPSID>
6.8 Deleting an SAP System

This section describes how to delete a single instance, a standalone engine or a complete SAP system with the *Uninstall* option of SAPinst.

**Caution**

- If you delete network-wide users or groups in an environment with Network Information System (NIS), other SAP installations might also be affected. Before you delete users or groups, make sure that they are no longer required.

**Prerequisites**

- This description assumes that you have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on with a user account that has the required authorization to run the SAPinst tool and the SAP system. For more information, see *Required User Authorization for the Installation* [page 37].

**Procedure**

1. *Start SAPinst* [page 49] and on the Welcome screen, choose:
2. Follow the instructions in the SAPinst input dialogs.

**Note**

For more information about the input parameters, place the cursor on the relevant field and press `F1` in SAPinst.

SAPinst first asks you which SAP instances you want to delete. Make sure that you delete the SAP instances in the order as described hereinafter.

3. If required, you can delete the directory `\usr\sap\trans` and its contents manually. SAPinst does not delete `\usr\sap\trans` because it might be shared.
© Copyright 2008 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Excel, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.

IBM, DB2, DB2 Universal Database, OS/2, Parallel Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400, iSeries, pSeries, xSeries, zSeries, System i, System i5, System p, System p5, System x, System z, System z9, z/OS, AFP, Intelligent Miner, WebSphere, Netfinity, Tivoli, Informix, i5/OS, POWER, POWER5, POWER5+, OpenPower and PowerPC are trademarks or registered trademarks of IBM Corporation.

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Oracle is a registered trademark of Oracle Corporation.

UNIX, X/Open, OSF/1, and Motif are registered trademarks of the Open Group.

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

Java is a registered trademark of Sun Microsystems, Inc.

JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, R/3, xApps, xApp, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP Business ByDesign, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.

These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies ("SAP Group") for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

This document was created using stylesheet 2006-12-31 (V5.1beta [= 6.0 for E3]) and XSLT processor SAXON 6.5.2 from Michael Kay (http://saxon.sf.net/), XSLT version 1.
Disclaimer
Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components. Any Java™ Source Code delivered with this product is only to be used by SAP’s Support Services and may not be modified or altered in any way.

Legal Software Terms

Terms for Included Open Source Software
This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. This software was developed using ANTLR.
2. SAP License Agreement for STLport
   SAP License Agreement for STLPort between
   SAP Aktiengesellschaft
   Systems, Applications, Products in Data Processing
   Dietmar-Hopp-Allee 16
   69190 Walldorf, Germany
   (hereinafter: SAP)
   and
   you
   (hereinafter: Customer)
   a) Subject Matter of the Agreement
      A) SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLport.org C++ library
         (STLport) and its documentation without fee.
      B) By downloading, using, or copying STLPort or any portion thereof Customer agrees to abide by the intellectual
         property laws, and to all of the terms and conditions of this Agreement.
      C) The Customer may distribute binaries compiled with STLPort (whether original or modified) without any
         royalties or restrictions.
      D) Customer shall maintain the following copyright and permissions notices on STLport sources and its
         documentation unchanged: Copyright 2001 SAP AG
      E) The Customer may distribute original or modified STLPort sources, provided that:
         ■ The conditions indicated in the above permissions notice are met;
         ■ The following copyright notices are retained when present, and conditions provided in accompanying
           permission notices are met:
           Copyright 1994 Hewlett-Packard Company
           Copyright 1996,97 Silicon Graphics Computer Systems Inc.
           Copyright 1997 Moscow Center for SPARC Technology.
           Copyright 1999,2000 Boris Fomichev
           Copyright 2001 SAP AG
   Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is
   hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
   copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company
   makes no representations about the suitability of this software for any purpose. It is provided “as is” without
   express or implied warranty.
   Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is
   hereby granted without fee, provided that the above copyright notice appear in all copies and that both that
   copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no
representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty. Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty. Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice. Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

b) Support and Maintenance
SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.
All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

c) Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights. Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

d) Limited Liability
A) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.
B) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.
C) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.
D) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.
E) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.
F) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services
Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 854621.

Documentation in the SAP Service Marketplace
You can find this document at the following address: https://service.sap.com/instguides
This page is intentionally left blank.